Development of e-Courses for B.Sc.(Agriculture) Degree Program

STAM 102
INTRODUCTION TO COMPUTER APPLICATIONS
# Index

<table>
<thead>
<tr>
<th>SN</th>
<th>Lecture</th>
<th>Page No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Introduction to Computers, Anatomy of Computers, Input and Output Devices</td>
<td>5-11</td>
</tr>
<tr>
<td>2</td>
<td>Units of Memory, Hardware, Software and Classification of Computers</td>
<td>12-17</td>
</tr>
<tr>
<td>3</td>
<td>Personal Computers, Types of Processors, Booting of Computer- warm and cold booting</td>
<td>18-20</td>
</tr>
<tr>
<td>4</td>
<td>Computer Viruses, Worms and Vaccines</td>
<td>21-24</td>
</tr>
<tr>
<td>5</td>
<td>Operating System – Some Fundamental DOS Commands, Rules for naming files in DOS and Types of files</td>
<td>25-37</td>
</tr>
<tr>
<td>6</td>
<td>WINDOWS: GUI, Desktop and its elements, Windows Explorer, Working with files and folders, Setting time and date, Starting and Shutting down Windows</td>
<td>38-55</td>
</tr>
<tr>
<td>7</td>
<td>MSWORD: Word-processing and units of document, features of word-processing packages. Creating, Editing, Formatting and Saving a document in MSWORD</td>
<td>56-68</td>
</tr>
<tr>
<td>8</td>
<td>MSEXCEL: Electronic Spreadsheets – concepts, packages. Creating, Editing and Saving a spreadsheet with MSEXCEL</td>
<td>69-77</td>
</tr>
<tr>
<td>9</td>
<td>Use of in-built functions and writing expressions</td>
<td>78-84</td>
</tr>
<tr>
<td>10</td>
<td>Data Analysis Tools- Correlation and Regression, t-test for two samples and ANOVA with One-way classification</td>
<td>85-97</td>
</tr>
<tr>
<td>11</td>
<td>t-test for two samples and ANOVA with One-way classification</td>
<td>98-103</td>
</tr>
<tr>
<td>12</td>
<td>CREATING GRAPHS</td>
<td>104-112</td>
</tr>
<tr>
<td>13</td>
<td>MSACCESS: Concept of Database- Units of database, creating database</td>
<td>113-125</td>
</tr>
<tr>
<td>14</td>
<td>Principles of Programming: Flow charts, illustrations through examples</td>
<td>126-134</td>
</tr>
<tr>
<td>15</td>
<td>Internet: World Wide Web (WWW), Concepts</td>
<td>135-142</td>
</tr>
<tr>
<td>16</td>
<td>Web Browsing and Electronic Mail</td>
<td>143-150</td>
</tr>
</tbody>
</table>
Introduction to Computers, Anatomy of Computers, Input and Output Devices

In human affairs we have reached a point where the problems that we must solve are no longer solvable without the aid of computers. I fear not computers but the lack of them.

ISAAC ASIMOV

Introduction to Computers

A computer can be defined as an electronic device capable of processing the data and producing the information.

The computer system essentially comprises three important parts –

1. input device,
2. central processing unit (CPU) and
3. output device.

The CPU itself is made of three components namely,

1. arithmetic logic unit (ALU),
2. memory unit, and
3. control unit.

Components of a computer system

![Diagram of Central Processing Unit]

- Input Unit
- Arithmetic Logic Unit
- Main Memory
- Control Unit
- Secondary Storage
- Output Unit
On broad basis, a computer performs the following tasks:

**Input:** Sending the data and command to the computer is known as input.

**Processing:** Work done by the computer with the help of processing hardware and software to produce results is known as processing.

**Output:** The result displayed by the computer is known as output.

**Storage:** A place to save result inside or outside the computer is known as storage.

**Anatomy of Computers**
The following are the parts of a desktop computer.

**Power Supply**
When you plug your power cable into your computer, you are actually plugging into a socket in the power supply unit that has been fitted inside your case. This component is responsible for converting the 240 volt AC mains power to low voltage DC power needed by computer components. The power supply generates +3.3V, +5V, +12V, -5V. These voltages must be constant, right up to the maximum current your system will draw under load.

**Monitor** - Commonly known as a "screen," the monitor gives you a visual display of what your computer is up to. Monitor displays are divided into pixels. The higher the pixel count, the higher the "resolution." Resolutions are measured in Rows x Columns. Common resolution settings are 640 x 480, 800 x 600, 1024 x 768, 1280 x 1024, etc.
Mother board
The mainboard I which is sometimes called a motherboard. This is usually the largest circuit-board in the computer, and every other component in the computer connects to it.

Central Processing Unit
The Central Processing Unit (CPU) is usually called either a CPU or just a Processor. The CPU is the brain of the system. It executes all the program code from the operating system and the applications the user runs and processing of data. It sends CPU commands to direct the actions of all the other components in the computer.

Main Memory or Random Access Memory (RAM)
RAM, which stands for Random Access Memory, is the short term memory that the computer uses to keep track of what it’s doing. If the computer loses power, anything stored in RAM is lost.
Storage Device

Computer storage device is any type of hardware that stores data. The most common type of storage device, which nearly all computers have, is a hard drive.

A Hard Drive

INPUT AND OUTPUT DEVICES

Input Devices

Input device is a hardware device that sends information to the computer.

Mouse

Mouse is a pointer device. The mouse allows an individual to control a pointer in a graphical user interface (GUI). Utilizing a mouse a user has the ability to perform various functions such as opening a program or file and does not require the user to memorize commands.

Digital camera

A type of camera that stores the pictures or video it takes in electronic format instead of to film.
**Web Cam**
A camera connected to a computer that allows anyone connected to the Internet to view still pictures or motion video of a user.

**Joystick**
A computer joystick allows an individual to easily navigate an object in a game such as navigating a plane in a flight simulator.

**Keyboard**
One of the main input devices used on a computer, a computer keyboard looks very similar to the keyboards of electric typewriters, with some additional keys.

**Microphone**
Sometimes abbreviated as mic, a microphone is a hardware peripheral that allows computer users to input audio into their computers.
Scanner
Input device that allows a user to take an image and/or text and convert it into a digital file, allowing the computer to read and/or display the scanned object.

Output Device
Any peripheral that receives and/or displays output from a computer. Below are some examples of different types of output devices commonly found on a computer.

Monitor
A monitor is a video display screen. Monitor is also called as Visual Display Unit (VDU) or Video Display Terminal (VDT).

**CRT (Cathode Ray Tube) Monitors** are built very similarly to older (tube) television sets. They are heavy, bulky, take up a lot of desk space, and emit radiation.

**LCD (Liquid Crystal Display) Monitors** are thin and flat. They are light, compact, take up very little desk space emit no known radiation.
**Printer**
A printer is an output device responsible for taking computer data and generating a hard copy of that data.

**Projector**

**Speakers**
Units of Memory, Hardware, Software and Classification of Computers

Units of Memory
The memory unit is the principal storage of the computer. All the data and instructions that the computer needs at a moment are stored here. All storage devices are characterized with the following features:
1. Speed
2. Volatility
3. Access method
4. Portability
5. Cost and capacity

Linking Memory with the other units

Basic Units of Measurement
The components of the computer can recognize only two states that is presence or absence of an electrical signal. Two symbols used to represent these two states are 0 and 1, and are known as BITS (an abbreviation for Binary Digits). 0 represents the absence of a signal, 1 represents the presence of a signal. A BIT is, therefore, the smallest unit of data in a computer and can either store a 0 or 1.
Since a single bit can store only one of the two values, there can possibly be only four unique combinations:

00 01 10 11

Bits are, therefore, combined together into larger units in order to hold greater range of values. BYTES are typically a sequence of eight bits put together to create a single computer alphabetical or numerical character. More often referred to in larger multiples, bytes may appear as Kilobytes (1,024 bytes), Megabytes (1,048,576 bytes), GigaBytes (1,073,741,824), TeraBytes (approx. 1,099,511,000,000 bytes), or PetaBytes (approx. 1,125,899,900,000,000 bytes).

Bytes are used to quantify the amount of data digitally stored (on disks, tapes) or transmitted (over the internet), and are also used to measure the memory and document size.

**Types of memory**

Computers use several different types of memory. They are:

1. **Main Memory / Primary Memory units**
   - Two most important are
     - RAM (Random Access Memory)
     - ROM (Read-only Memory)
   - They work in different ways and perform distinct functions
   - CPU Registers
   - Cache Memory

2. **Secondary Memory/Auxiliary Memory**
   - Also termed as ‘auxiliary’ or ‘backup’ storage, it is typically used as a supplement to main storage. It is much cheaper than the main storage and stores large amount of data and instructions permanently. Hardware devices like magnetic tapes, Floppy Disk, Hard Disk, Optical disks, Compact Disk (CD), Digital Versatile Disk (DVD) and Blu-ray Disc (BD) fall under this category.

Computer’s memory can be classified into two types – RAM and ROM.

**RAM or Random Access Memory** is the central storage unit in a computer system. It is the place in a computer where the operating system, application programs and the data in current
use are kept temporarily so that they can be accessed by the computer’s processor. The more RAM a computer has, the more data a computer can manipulate.

**Random access memory**, also called the Read/Write memory, is the temporary memory of a computer. It is said to be ‘volatile’ since its contents are accessible only as long as the computer is on. The contents of RAM are cleared once the computer is turned off.

ROM or Read Only Memory is a special type of memory which can only be read and contents of which are not lost even when the computer is switched off. It typically contains manufacturer’s instructions. Among other things, ROM also stores an initial program called the ‘bootstrap loader’ whose function is to start the computer software operating, once the power is turned on.

**Hardware**
Hardware, in the computer world, refers to the physical components that make up a computer system. There are many, many different kinds of hardware that can be installed inside and connected to the outside of a computer. However, there are several standard pieces of hardware that can be found as part of nearly every computer:

- Input Devices - Keyboard, Mouse...
- CPU - (Brain) Named on model: 80286, 80386, 80486, Pentium, P-II, Core 2 Duo...
- Output Devices - VDU/Screen, Printer
- Memory - RAM - Active, temporary ROM - Permanent.
- Ancillary Storage devices: Floppy, Hard Disk, CD ROM, Tapes etc.
- Scanner, Modem, Digital Camera, Video adopter, Computer Projector, Slide maker, etc.

**Software**
Software is a general term for the various kinds of programs used to operate computers and related devices. Software is classified as follows:
System software
System software refers to the operating system and all utility programs that manage computer resources at a low level. Operating system controls and manages the computing resources. Examples of operating system: Windows, Unix, MSDOS, Linux, Mac.

Systems software includes compilers, loaders, linkers, and debuggers. Applications software comprises programs designed for an end user, such as word processors, database systems, and spreadsheet programs. Application software makes computer popular and easy to use. Common application software:

- Microsoft Word, WordPerfect
- PowerPoint
- Netscape, Internet Explorer
- PhotoShop, Photo-Paint
- Quick Time
- Dreamweave
Classification of Computers

Computers are available in different shapes, sizes and weights, due to these different shapes and sizes they perform different sorts of jobs from one another. They can also be classified in different ways. All the computers are designed by the qualified computer architectures that design these machines as their requirements.

A computer that is used in a home differs in size and shape from the computer being used in a hospital. Computers act as a server in large buildings, while the computer also differs in size and shape performing its job as a weather forecaster.

A student carrying a laptop with him to his college is different in shape and size from all the computers mentioned above. Computers are classified as follows:

**Super computer**

The biggest in size, the most expensive in price than any other is classified and known as super computer. It can process trillions of instructions in seconds. Governments specially use this type of computer for their different calculations and heavy jobs. Different industries also use this huge computer for designing their products. In most of the Hollywood's movies it is used for animation purposes. This kind of computer is also helpful for forecasting weather reports worldwide.
**Mainframes**

Another giant in computers after the super computer is Mainframe, which can also process millions of instruction per second and capable of accessing billions of data. This computer is commonly used in big hospitals, air line reservations companies, and many other huge companies prefer mainframe because of its capability of retrieving data on a huge basis.

**Minicomputer**

This computer is next in the line but less offers less than mainframe in work and performance. These are the computers, which are mostly preferred by the small type of business personals, colleges, etc.

**Personal computers**

Personal computer is the computer mostly preferred by the home users. These computers are lesser in cost than the computers given above and also, small in size; they are also called PCs in short for Personal computers. This computer is small in size. Today this is thought to be the most popular computer in all.

**Notebook computers**

Having a small size and low weight the notebook is easy to carry to anywhere. A student can take it with him/her to his/her school in his/her bag with his/her book. This is easy to carry around and preferred by students and business people to meet their assignments and other necessary tasks. The approach of this computer is also the same as the Personal computer. It can store the same amount of data and having a memory of the same size as that of a personal computer.
Personal Computers, Types of Processors, Booting of Computer- warm and cold booting

Personal Computer

A personal computer (PC) is any general-purpose computer whose size, capabilities, and original sales price make it useful for individuals, and which is intended to be operated directly by an end user, with no intervening computer operator.

This is in contrast to the batch processing or time-sharing models which allowed large expensive mainframe systems to be used by many people, usually at the same time, or large data processing systems which required a full-time staff to operate efficiently.

A personal computer may be a desktop computer, a laptop, tablet PC or a handheld PC (also called palmtop). Software applications for personal computers include word processing, spreadsheets, databases, Web browsers and e-mail clients, games, and myriad personal productivity and special-purpose software. Modern personal computers often have high-speed or dial-up connections to the Internet, allowing access to the World Wide Web and a wide range of other resources.

A PC may be used at home, or may be found in an office. Personal computers can be connected to a local area network (LAN) either by a cable or wirelessly.
While early PC owners usually had to write their own programs to do anything useful with the machines, today's users have access to a wide range of commercial and non-commercial software which is provided in ready-to-run form. Since the 1980s, Microsoft and Intel have dominated much of the personal computer market with the Wintel platform.

The capabilities of the personal computer have changed greatly since the introduction of electronic computers. By the early 1970s, people in academic or research institutions had the opportunity for single-person use of a computer system in interactive mode for extended durations, although these systems would still have been too expensive to be owned by a single person. The introduction of the microprocessor, a single chip with all the circuitry that formerly occupied large cabinets, led to the proliferation of personal computers after 1975.

**Types of Processors**

The Central Processing Unit (CPU) or the processor is the portion of a computer system that carries out the instructions of a computer program, and is the primary element carrying out the computer's functions.

Basically there are two types of processors which are manufactured by two companies and they are Intel and AMD. Now there are a number of varieties available in both Intel and AMD.

Intel offers Pentium Pro, Pentium II, Celeron, Pentium II Xeon, Pentium III, Pentium II and III Xeon, Celeron with Pentium III Based, Pentium 4, Pentium M, Intel Core, Dual Core Xeon LV, Intel Pentium Dual Core, Intel Core 2, Pentium Duo, Pentium Dual Core, Core 2 Quad, Intel Pentium 2 Dual Core Processor.

AMD processors include AMD Athlon, AMD Athlon 64, AMD Athlon X2, AMD Athlon Xp, AMD Duron, AMD Sempron, AMD Turion, MD Opteron and AMD Phenom 1.

Moreover, there are various processors offered by various companies like Macintosh processor. In other words different processors are used for different types of technology.

**Booting of Computer – Warm and Cold Booting**

Booting of computer is the process of powering it on and starting the operating system. Booting loads the first piece of software that starts a computer. Because the operating system is
essential for running all other programs, it is usually the first piece of software loaded during the boot process.

**Cold boot** is the process of starting a computer from a powered-down, or off state. Cold boot is also called as hard boot.

**Warm boot** refers to restarting a computer that is already turned on via the operating system. Restarting it returns the computer to its initial state. A warm boot is sometimes necessary when a program encounters an error from which it cannot recover. On PCs, you can perform a warm boot by pressing the Control, Alt, and Delete keys simultaneously. On Macs, you can perform a warm boot by pressing the Restart button.
Computer Viruses, Worms and Vaccines

Computer Viruses

Computer virus is a small software program that is designed to spread from one computer to another and to interfere with computer operation. A true virus is capable of self replication on a machine. Virus may spread between files or disks.

- There are estimated 30,000 computer viruses in existence.
- Over 300 new ones are created each month.
- First virus was created to show loopholes in software.
- Today almost 87% of all viruses are spread through the internet.

Symptoms of Virus Attack

- Computer runs slower than usual
- Computer no longer boots up
- Screen sometimes flicker
- Speaker beeps periodically
- System crashes for no reason
- Files/directories sometimes disappear
- Denial of Service (DoS)

Types Computer Viruses

- Trojan Horse
  - Requires Windows to work
  - Once infected, runs in the background
- Worm
  - Spread over network connection
  - Worms replicate
- Macro
  - Specific to certain applications
  - Comprise a high percentage of the viruses
- E-mail viruses
An e-mail virus travels as an attachment to e-mail messages, and usually replicates itself by automatically mailing itself to dozens of people in the victim's e-mail address book.

Some e-mail viruses don't even require a double-click -- they launch when you view the infected message in the preview pane of your e-mail software.

**Worms**

A worm is a small piece of software that uses computer networks and security holes to replicate itself. A copy of the worm scans the network for another machine that has a specific security hole. It copies itself to the new machine using the security hole, and then starts replicating from there, as well.

Worms use computer time and network bandwidth when they replicate. A worm called Code Red made huge headlines in 2001. Experts predicted that this worm could clog the Internet so effectively that things would completely grind to a halt.

A worm usually exploits some sort of security hole in a piece of software or the operating system. For example, the Slammer worm (which caused mayhem in January 2003) exploited a hole in Microsoft's SQL server.

Worms normally move around and infect other machines through computer networks. Using a network, a worm can expand from a single copy incredibly quickly. The Code Red worm replicated itself more than 250,000 times in approximately nine hours on July 19, 2001.

Protect computer against viruses:

- Gain knowledge about viruses
- Proper configurations
- Run only necessary programs
- Install Anti-virus software and update

**Vaccines**

Vaccines or Antivirus software is a computer program that detects, prevents, and takes action to disarm or remove malicious software programs, such as viruses and worms. New viruses, worms, and other threats are created by cyber terrorists and discovered every day. So updating
antivirus software is periodically mandatory. List of some top Anti Virus Programs which are very useful to users:

**Norton AntiVirus** – Norton AntiVirus is the most popular and secure virus scanner for checking boot sector records at startup. The live update feature automatically installs new updates for regular protection against viruses.

**AVG Free Edition** – AVG Resident Shield provides real-time protection executions of files and programs. It features a smart e-mail scanner, virus updates and virus vault for secure handling of the files which are infected by viruses. The base version for windows is Free for private and non-commercial use.

**McAfee VirusScan for Windows**: This antivirus package detects all virus types, including Word and Excel macros; boot-sector infections; and file, multipartite, stealth, polymorphic, and encrypted viruses.

**Kaspersky Anti-Virus Personal Pro** – It is a commonly used virus protection solution offering full protection against macro-viruses and unknown viruses.

**ESET NOD32 Antivirus** – ESET NOD32 Anti-virus is available as an anti-virus for small businesses, individuals and for large networks.

**avast! Home Edition** – A free antivirus solution for scanning disk, CDs, and E-mail.
Panda Antivirus Platinum – It is a complete virus protection package for home and business users. It comes with an easy installation and automatic protection from latest viruses.

Avira - Windows and Linux anti virus, firewall, anti spam, recovery solutions against malware infection
LECTURE SCHEDULE 5

Operating System – Some Fundamental DOS Commands, Rules for naming files in DOS and Types of files

Operating System
Operating system is a set of software that controls and manages hardware and basic system operations for a computer. The operating system loads programs into the computer’s memory, runs these programs, and manages peripherals like disks and printers.

Example:

Disk Operating System (DOS)

Windows

LINUX

Mac
Disk Operating System (DOS)

- In the 1980s or early 1990s, the operating system that shipped with most PCs was a version of the Disk Operating System (DOS) created by Microsoft: MS-DOS.
- MS-DOS is a disk-based, single-user, single-task and character based user interface (CUI) operating system.

Goto MSDOS from Windows Operating System:
Click Start Button → Choose Program → Choose Accessories → Click Command Prompt as shown below:

Or Click Start Button → Choose Run → Type cmd in the Open tab as shown below:
Command Prompt will get displayed as shown:

The DOS commands can be entered in the command prompt and executed.
Some Examples of DOS commands

DIR Command

The dir command allows you to see the available files in the current and/or parent directories. Examples:

1. **DIR**

   Lists all files and directories in the directory that you are currently in.

   ![DIR Command Example](image)

2. **dir /w**

   If information on the date / time and other information on the files are not needed, then this command can be used to list just the files and directories going horizontally, taking as little as space needed.
3. `dir /on`

List the files in alphabetical order by the names of the files.

4. `dir /o-n`

List the files in reverse alphabetical order by the names of the files.
FORMAT Command

FORMAT command is used to erase all information of a diskette or fixed drive.

1. format a:

   Would erase all the contents off a disk. Commonly used on a diskette that has not been formatted or on a diskette you wish to erase.

2. format a: /q

   Quickly erases all the contents of a floppy diskette. Commonly used to quickly erase all information on the diskette.

3. format c:

   This would erase all the contents of C: hard disk drive. In other words, unless you wish to erase all your computer's information, this command should not be done unless you're planning to start over.
COPY Command

COPY command allows to copy one or more files to an alternate location.

Examples:

1. copy *.* a:
   
   Copy all files in the current directory to the a disk drive.

2. copy file1.txt file2.txt

   Copy the contents of file1.txt to file2.txt

3. copy myfile1.txt+myfile2.txt

   Copy the contents in myfile2.txt and combines it with the contents in myfile1.txt.

PATH Command

Path is used to specify the location where MS-DOS looks when using a command. For example, when using the command "format", if the path is not specified to where the command is you will receive bad command or file name.
Example:

![Image of command prompt]

**LABEL Command**

Label is used to view or change the label of the computer disk drives.

Example:

```plaintext
label a: mydisk
```

This would label the disk currently in the drive to "mydisk", but will not label if your disk is write protected.

**VOL Command**

VOL command displays the volume information about the designated drive.
**MD (Make Directory) Command**

MD command allows to create directories in MS-DOS.

Examples:

1. `md test`
   
   Creates the "test" directory in the directory in the currently directory.

2. `md c:\test`

   Creates the "test" directory in the c:\ directory.

**CD (Change Directory) Command**

CD (Change Directory) is a command used to switch directories in MS-DOS.

Examples:

1. `cd\`

   Goes to the highest level, the root of the drive.
2. cd..

Goes back one directory.
3. `cd`

Typing `cd` alone will print the working directory.

**DEL Command**

DEL command is used to delete files from the computer. Deleting files from MS-DOS does not send files to the recycle bin.

Examples:

1. `del test.tmp`

   Deletes the `test.tmp` in the directory that you currently are in, if the file exists.

2. `del c:\windows\test.tmp`

   Delete the `c:\windows\test.tmp` in the windows directory if it exists.

**Rules for naming files in DOS**

1. The combination of the following characters can be used for writing names of directories and files:
Alphabets A to Z (both capital and small).
Digits 0 to 9.
Special characters like spaces ' ! A $o & # % '{}' []+-- .
2. Some special characters which cannot be used are? / \ : 1< > II *.
3. There are some words specifically reserved for special files and are not allowed if used singly. They are CON, COM1, COM2, COM3, COM4, AVX, LPT1, LPT2, LPT3, PRN, NUL. These words can be used in combination such as ASCon, deltacom1, Panamavx. etc.
4. Files with extension names like .EXE, .COM and .BAT are called executable files and are given a special status by DOS.
5. Dot (.) is allowed only once.

Types of files in DOS

DOS supports a wide variety of files. The type of the file can be identified with the extension of the file in the filename. The three letters following the name of the file is called as the extension of the file.

Examples:

.bak

Used by programs and users to make a copy of an existing file for safety and/or archive purposes.

.bas

A basic computer-language program file.

.bat

This is used for a batch file. Such a file is a series of commands in mostly plain english which perform an operation in DOS automatically. They come with some programs and may also be written by a user to make shortcuts or perform operations like sorting or backups.
**.bin**

A binary file.

**.c**

A file of programming language in the C format.

**.dat**

Used to hold information about a particular aspect of a program or about a particular operation. The latter may update a .dat file to reflect recent changes. Other operations in the program may then view this file and other .dat files while determining a course of action.

**.db or .dbf**

These are used by data base programs to hold the users’ data information. Other programs may use them to hold information used by the application itself for such things as printer specifications regarding printer selection by the user.

**.dir**

Used to house a directory list, especially for communications programs.

**.exe**

An executable file.

**References**

1. [http://www.chebucto.ns.ca/~ak621/DOS/DOS-Ext.html](http://www.chebucto.ns.ca/~ak621/DOS/DOS-Ext.html)
Lecture Schedule 6

Windows: GUI, Desktop and its elements, Windows Explorer, Working with files and folders, Setting time and date, Starting and Shutting down Windows

Windows

- An operating system with a graphical user interface (GUI).
- Graphical User Interface (GUI) is a user interface based on graphics (icons and pictures and menus) instead of text; uses a mouse as well as a keyboard as an input device.

Versions

- Windows 98
- Windows Me
- Windows NT
- Windows 2000
- Windows XP
- Windows Server 2003
- Windows Vista
- Windows 7

Desktop and its elements

- In Windows operating system the basic working platform is the desktop.
- It is also the opening screen of the Windows operating system.
• The desktop contains:
  – Taskbar
  – Icons

**Taskbar**

• Taskbar is usually a narrow strip present at the bottom of the screen.
Windows Vista Taskbar

Icons

- Icons are small pictures/images representing applications.
- Each icon has a label telling the name of the application it represents.

Example:

Computer

- lists the contents of floppy disk, hard disk, CD-ROM drive, and mapped network drives
Windows Explorer

Windows Explorer is a file manager application used to view and manage drives, folders, and files. Windows Explorer can be opened by clicking on

Start > My Computer or using the short cut key Windows + E while in Windows Xp
Start > Computer or using the short cut key Windows + E while in Windows Vista.
**Working with files and folders**

Folders are the basic organizational building blocks of any computer system. Without folders it would be virtually impossible to keep track of all the files that are found on even the smallest system. New folders can be created just about anywhere, but three methods are shown below.

**To create a folder**

New Folder On Desktop - Right click anywhere on an open area of the desktop. Select New and then click Folder. A new folder with the default name New Folder will be created on the desktop. Either accept the default name New Folder (bad idea) by hitting the enter key or type a new name for the folder (good idea) and then hit enter on the keyboard.
To open a folder
- double click the folder with mouse
  or
- right click the folder and click open
tab from the right context menu.

To Rename a folder
- Locate and select the folder to be renamed.
- Right click the folder
- Select rename from the popup menu
To Copy and Paste a folder

- Locate and select the folder you want to copy.
- Choose copy
- Choose the Destination location to copy the folder
- Choose paste

<table>
<thead>
<tr>
<th>Cut</th>
<th>Copy</th>
<th>Paste</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Shortcut</td>
<td>Delete</td>
<td>Rename</td>
</tr>
<tr>
<td>Properties</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
To delete a folder

- Locate and select the folder you want to delete.
- Choose delete.
• The deleted file is moved to the Recycle bin.
• If you want the deleted file back you can open the recycle bin folder and restore the deleted file.
• If you want file to be completely deleted without getting stored in the Recycle Bin then choose the file and Press Shift + Del keys in the keyboard. This will erase the file even without storing the file in the Recycle Bin.
• Once you delete the file with Shift + Del combination keys it is not possible for us to restore the file again.

**Opening a program file**

Click Start→Programs→Select the program and double click
**Locating Most Recent Files**

Click Start → Documents

**Finding Files**

Click Start → Search
Anatomy of a Window

• A rectangular area on the desktop that is used by an application is called a Window.

Although the contents of every window are different, all windows share some things in common. For one thing, windows always appear on the desktop—the main work area of your screen. In addition, most windows have the same basic parts:
- Title bar. Displays the name of the document and program (or the folder name if you're working in a folder).
- Minimize, Maximize, and Close buttons. These buttons hide the window, enlarge it to fill the whole screen, and close it, respectively (more details on these shortly).
- Menu bar. Contains items that you can click to make choices in a program.
- Scroll bar. Lets you scroll the contents of the window to see information that is currently out of view.
- Borders and corners. You can drag these with your mouse pointer to change the size of the window.
Setting Time and Date

1. Click Start, and then click Control Panel.

2. Click Date and Time icon in the Control Panel Window.
3. Set the current time and date with the help of the Date and Time properties window as shown below. Then click Apply in the bottom right corner of the Date and Time properties window.

4. Check the date and time that is set in the system tray as shown.
Starting Windows

1. Switch on the power supply.
2. Switch on the CPU and Monitor.
3. Windows XP splash screen will be displayed as shown below:
4. Enter the password to load your personal setting in the tab shown below:
Shutting Down

- Click Start Button → Choose Turn Off Computer option

- Click the Turn Off option in the Shut Down Dialog Box.
**LECTURE SCHEDULE 7**

**MSWORD: Word-processing and units of document, features of word-processing packages. Creating, Editing, Formatting and Saving a document in MSWORD**

**Word-processing**

- Word-processing the process of using computer to create, edit and print documents.
- Word processing is creating documents with:
  - Various font face, font styles, font sizes, font colors (e.g., one, two, three)
  - Different text effects (MS Word is a product of Microsoft Corporation)
  - Different alignments as shown below:

  ![Alignment Examples](image)

- Facility to automatically correct misspelled words and grammatical mistakes
- The ability to see how the document will look

---

Office of the Dean Engineering
Tamil Nadu Agricultural University
Coimbatore- 641 003

No. Dean/AEC & RI/Edn/Examiners/Practical Exam/COM

This is to demonstrate the various alignments available in the word processing software. Using this facility, the users can left, right and centre the text in their documents.

- Facility to automatically correct misspelled words and grammatical mistakes
- The ability to see how the document will look
To perform word processing, a special program called a word processor is in need.

A word processor enables you to create a document, store it electronically on a disk, display it on a screen, modify it by entering commands and characters from the keyboard, and print it on a printer.

Examples of Word processors

- Wordstar
- Writer
- Leap
- WordPerfect
- MS Word

**MSWORD**

- MSWORD is a word processor from Microsoft.
- A computer program that enable us to create a document, edit, format, print and also save it for future use.

**Word Screen**
Features of word processing

Word processors vary considerably, but all word processors support the following basic features:

**Insert text**: Allows you to insert text anywhere in the document.

**Delete text**: Allows you to erase characters, words, lines, or pages as easily as you can cross them out on paper.

**Cut and paste**: Allows you to remove (cut) a section of text from one place in a document and insert (paste) it somewhere else.

**Copy**: Allows you to duplicate a section of text.
Page size and margins: Allows you to define various page sizes and margins, and the word processor will automatically readjust the text so that it fits.

Search and replace: Allows you to direct the word processor to search for a particular word or phrase. You can also direct the word processor to replace one group of characters with another everywhere that the first group appears.

Word wrap: The word processor automatically moves to the next line when you have filled one line with text, and it will readjust text if you change the margins.

Print: Allows you to send a document to a printer to get hardcopy.

Word processors that support only these features (and maybe a few others) are called text editors. Most word processors, however, support additional features that enable you to manipulate and format documents in more sophisticated ways. These more advanced word processors are sometimes called full-featured word processors. Full-featured word processors usually support the following features:

File management: Many word processors contain file management capabilities that allow you to create, delete, move, and search for files.

Font specifications: Allows you to change fonts within a document. For example, you can specify bold, italics, and underlining. Most word processors also let you change the font size and even the typeface.

Footnotes and cross-references: Automates the numbering and placement of footnotes and enables you to easily cross-reference other sections of the document.

Graphics: Allows you to embed illustrations and graphs into a document. Some word processors let you create the illustrations within the word processor; others let you insert an illustration produced by a different program.

Headers, footers, and page numbering: Allows you to specify customized headers and footers that the word processor will put at the top and bottom of every page. The word processor automatically keeps track of page numbers so that the correct number appears on each page.

Layout: Allows you to specify different margins within a single document and to specify various methods for indenting paragraphs.
**Macros:** A *macro* is a character or word that represents a series of keystrokes. The keystrokes can represent text or commands. The ability to define macros allows you to save yourself a lot of time by replacing common combinations of keystrokes.

**Merges:** Allows you to merge text from one file into another file. This is particularly useful for generating many files that have the same format but different data. Generating mailing labels is the classic example of using merges.

**Spell checker:** A utility that allows you to check the spelling of words. It will highlight any words that it does not recognize.

**Tables of contents and indexes:** Allows you to automatically create a table of contents and index based on special codes that you insert in the document.

**Thesaurus:** A built-in thesaurus that allows you to search for synonyms without leaving the word processor.

---

**Creating a New Document**

- Switch on the computer
- Windows displays a desktop screen with many icons on it.
- Search for Microsoft Word icon, point it with the help of the mouse and double click to select the application.
- If MSWord icon is not on the desktop screen then Click Start → All Programs → Microsoft Word as shown below:
• The opening word screen will get displayed as shown below. The opening screen of word will automatically open a new document and the default name of that document will be Document1.

- If you've already started Word, you create a new document by clicking New on the File menu. In the New Document task pane that opens, click Blank document.
- In the upper-left corner of the document, or page, is the insertion point, a blinking vertical line. Typed content will appear there.
- Keep typing continuously even if the end of the line encountered. With the help of the word wrap property the lines will be automatically displayed in the next consecutive lines.
- Press ENTER to start another paragraph.

**Navigating Through Document**

• Movement around the created document is achieved with the help of the following operations:
Selecting the text in the document

- To select the document in the text the following operations can be performed:

<table>
<thead>
<tr>
<th>To perform this action...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>To select one character to the right</td>
<td>SHIFT+RIGHT ARROW</td>
</tr>
<tr>
<td>To select one character to the left</td>
<td>SHIFT+LEFT ARROW</td>
</tr>
<tr>
<td>To select to the beginning of a word</td>
<td>CTRL+SHIFT+LEFT ARROW</td>
</tr>
<tr>
<td>To select to the end of a line</td>
<td>SHIFT+END</td>
</tr>
<tr>
<td>To select to the beginning of a line</td>
<td>SHIFT+HOME</td>
</tr>
<tr>
<td>To select the entire document</td>
<td>CTRL+A</td>
</tr>
</tbody>
</table>

Editing the document

- Cut
  - Cut operation removes the selection from the active document and places it on the clipboard.
  - Select the text to be cut in the document.
- **Copy**
  
  o Copies the selection to the clipboard
  
  o Select the text to be copied in the document.
  
  o Go to Edit menu and select Copy option or click the copy icon () in the toolbar or make use of the shortcut key combination Ctrl+C to copy the selected text.

- **Paste**
  
  o Paste inserts the contents of the clipboard at the insertion point (cursor) or whatever is selected.
  
  o First go to the place where you want to display the cut text.
  
  o From the Edit menu select Paste option or click paste icon () in the toolbar or press the shortcut key Ctrl+V

- **Find and Replace**
  
  o Find searches for specified text in the active document
  
  o To find a specified text in the document go to Edit menu choose find option or click the find icon () on the toolbar or make use of the shortcut key combination Ctrl+F.
  
  o The Find and Replace dialog box will get displayed.
o Enter the text to be searched in the Find what tab.

o Clicking the Find Next button the specified text will be located in the document.

o Replace searches for and replaces specified text.

o To replace go to edit menu and select Replace option or click the replace icon in the toolbar or make use of the shortcut key combination Ctrl+H.

o Find and Replace dialog will get displayed.

o Clicking Find Next and Replace buttons the specified text will be replaced.

o To replace all the instance of the text lecture with the text lecture schedule click Replace All button in the Find and Replace window.
Then every instance of the text lecture in the document will get replaced with the text lecture schedule.

**Formatting the Document**

- **Font**
  - Font change font style, size, color and a large number of other features.
  - To change the font style, size of a selected text go to format menu and select Font option or click the font icon (A) in the format toolbar.
  - The Font dialog box will get displayed.

  ![Font dialog box](image)

  - In the Font dialog box choose font face, font style, font size, font color etc.
  - Click OK button then the applied font effects will get reflected in the document.
• **Bold, Italic and Underline**
  o Bold, Italic, Underline - Format selected text: **Bold**, *Italic*, or *Underlined*
  o To bold the text press Ctrl + B or click the bold icon (B) on the toolbar
  o To underline the text press Ctrl + U or click the underline icon (U) on the toolbar
  o To italics the text press Ctrl + I or click the italic icon (I) on the toolbar

• **Paragraph**
  o Paragraph under format menu indents a paragraph using either margin or place some chosen amount of space before or after the paragraph.
  o Select the paragraph if already entered or simply go Format menu and choose Paragraph option or click the paragraph icon (¶) in the toolbar.
  o Paragraph dialog box will get displayed.
In the paragraph window we can set Alignment, Indentation and Spacing for paragraphs.

Click OK will reflect the changes in the document accordingly.

**Saving the document**

- To save the document for the first time click File Menu→Choose Save As
- Save As dialog Box will get displayed.
- Select the directory where you want to save or create a new folder by clicking New Folder icon.
- Enter the file name in the File name box.
• Click Save. The file is saved under the new name.

• To save subsequently click on Save from File Menu.

• Or hold the Ctrl. Key and press S from keyboard.

• Or click Save button ( ) in the standard toolbar.
LECTURE SCHEDULE 8

MSEXCEL: Electronic Spreadsheets – concepts, packages. Creating, Editing and Saving a spreadsheet with MSEXCEL

Electronic Spreadsheet

• An electronic spreadsheet is the computer equivalent of a paper ledger sheet. It consists of a grid made from columns and rows.

![Paper ledger vs. computer ledger]

• Spreadsheet program allows us to create professional spreadsheets and charts.
• It performs numerous functions and formulas to assist us in our projects.

Electronic Spreadsheet Packages

• Examples of spreadsheet programs are:
  – Lotus 1-2-3
  – Corel's QuattroPro
  – MS Excel

• Excel is a spreadsheet program from Microsoft, a component of Microsoft Office for business applications.
Starting Microsoft Excel

- Double click on the Microsoft Excel icon on the desktop.
- Click on Start --> Programs --> Microsoft Excel

Concepts

- Spreadsheets are commonly referred to as workbook in Excel.
- Workbooks are made up of
  - columns
  - rows
  - and their intersections are called cells
- A workbook may contain one or more worksheets.
Definition of column in the worksheet

- The column is defined as the vertical space that is going up and down the window. Letters are used to designate each column’s location.
Definition of column in the worksheet

- The row is defined as the horizontal space that is going across the window. Numbers are used to designate each row's location.
Definition of cell in the worksheet

- The cell is defined as the space where a specified row and column intersect.
- Each cell is assigned a name according to its column letter and row number.

What a cell can contain?

- A cell may contain any one of the following types of data
  - text (labels)
  - number data (constants)
  - formulas (mathematical equations that do all the work)

<table>
<thead>
<tr>
<th>Data types</th>
<th>Examples</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>LABEL</td>
<td>Name or ID or Days</td>
<td>anything that is just text</td>
</tr>
<tr>
<td>CONSTANT</td>
<td>5 or 3.75 or -7.4</td>
<td>any number</td>
</tr>
<tr>
<td>FORMULA</td>
<td>=5+3 or = 8*5+3</td>
<td>mathematics equation</td>
</tr>
</tbody>
</table>
### Navigating Through Cells

<table>
<thead>
<tr>
<th>Movement</th>
<th>Key stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>One cell up</td>
<td>up arrow key</td>
</tr>
<tr>
<td>One cell down</td>
<td>down arrow key or enter</td>
</tr>
<tr>
<td>One cell left</td>
<td>left arrow key</td>
</tr>
<tr>
<td>One cell right</td>
<td>right arrow key or tab</td>
</tr>
<tr>
<td>Top of the worksheet (cell A1)</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>End of the worksheet (last cell with data)</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>End of the row</td>
<td>Ctrl+right arrow key</td>
</tr>
<tr>
<td>End of the column</td>
<td>CTRL+down arrow key</td>
</tr>
</tbody>
</table>

### Selecting Cells

<table>
<thead>
<tr>
<th>Cells to select</th>
<th>Mouse action</th>
</tr>
</thead>
<tbody>
<tr>
<td>One cell</td>
<td>Click once in the cell</td>
</tr>
<tr>
<td>Entire row</td>
<td>click the row label</td>
</tr>
<tr>
<td>Entire column</td>
<td>click the column label</td>
</tr>
<tr>
<td>Entire worksheet</td>
<td>click Ctrl + A sheet button</td>
</tr>
<tr>
<td>Cluster of cells</td>
<td>drag mouse over the cells or hold down the SHIFT key while using the arrow keys</td>
</tr>
</tbody>
</table>
Creating Spreadsheet

- Move to the cell where you want to enter data and enter words or numbers.
- If data is already in the cell it will be replaced without you having to cut or delete the previous data.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I-B.Sc.(Agri.) Mid Semester Mark List</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>STAM101 Mark</td>
<td>STAM102 Mark</td>
</tr>
<tr>
<td>3</td>
<td>Angaleeswari</td>
<td>87</td>
<td>85</td>
</tr>
<tr>
<td>4</td>
<td>Bharathi</td>
<td>92</td>
<td>94</td>
</tr>
<tr>
<td>5</td>
<td>Covardhanan</td>
<td>73</td>
<td>90</td>
</tr>
<tr>
<td>6</td>
<td>Dananjayen</td>
<td>54</td>
<td>58</td>
</tr>
</tbody>
</table>

Editing Spreadsheet

- To edit the contents of a cell
  - Select the cell, type the new contents and press enter. The new entry will be replacing the existing contents
  - Or select the cell to be edited, click on the Formula bar or double click the cell then edit the contents and press enter.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I-B.Sc.(Agri.) Mid Semester Mark List</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>STAM101 Mark</td>
<td>STAM102 Mark</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Angaleeswari</td>
<td>87</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Bharathi</td>
<td>92</td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Covardhanan</td>
<td>73</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Dananjayen</td>
<td>54</td>
<td>58</td>
<td></td>
</tr>
</tbody>
</table>

- To insert a row in the spreadsheet
  - First click on the row number and choose Rows from the Insert menu. This will insert a row before the selected row.
To insert a column in the spreadsheet

First click on the column label (letter) and choose Columns from the Insert menu. This will insert a column immediately left of the selected column.

Saving Spreadsheet

Click on Save As from File menu.

In the Save As dialog box

- Select the directory
- Enter the file name
- Click on Save button
• To save subsequently Click on Save from File menu
• Or hold the Ctrl. Key and press Enter key
• Or press Save button (✓) in the Tool Bar.
Use of in-built functions and writing expressions

In-built Functions
- A function is an in-built program, which is used to do a particular task.
- Functions take the input and will give the result as the output.
- Based on the input and output data, the functions are categorized as:
  - String functions
  - Arithmetic functions
  - Date functions
  - Logical functions
  - Group functions

Use of in-built function SUM()
To use in-built functions enter the data to prepare mark list of the I- B.Sc.(Agriculture) students in the spreadsheet.

<p>| | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>STAM101 Mark</td>
<td>STAM102 Mark</td>
<td>AGR101 Mark</td>
<td>PBG101 Mark</td>
</tr>
<tr>
<td>3</td>
<td>Angaleeswari</td>
<td>87</td>
<td>85</td>
<td>86</td>
<td>84</td>
</tr>
<tr>
<td>4</td>
<td>Bharathi Raja</td>
<td>92</td>
<td>94</td>
<td>96</td>
<td>97</td>
</tr>
<tr>
<td>5</td>
<td>Covardhanan</td>
<td>73</td>
<td>90</td>
<td>64</td>
<td>58</td>
</tr>
<tr>
<td>6</td>
<td>Dananjayen</td>
<td>54</td>
<td>58</td>
<td>60</td>
<td>63</td>
</tr>
<tr>
<td>7</td>
<td>Elevanthan</td>
<td>78</td>
<td>76</td>
<td>77</td>
<td>75</td>
</tr>
<tr>
<td>8</td>
<td>Gayathri</td>
<td>66</td>
<td>56</td>
<td>57</td>
<td>86</td>
</tr>
<tr>
<td>9</td>
<td>Hariprasad</td>
<td>61</td>
<td>65</td>
<td>66</td>
<td>64</td>
</tr>
</tbody>
</table>

- Using the in-built function SUM() we can calculate the total scored by each and every student in I-B. Sc. (Agri.).
- Add Total column in the spreadsheet as shown below:
• Place the mouse pointer in the cell with the address F3
• The F3 cell is the one which should display the total mark scored by the student namely Angaleeswari in the above example.
• Click on Insert Menu → Function
• or Select f, in the Formula bar
• Insert Function dialog box will get displayed as shown below:

![Insert Function dialog box]

• Select SUM function and click OK button in the Insert Function dialog box.
• The function Argument dialog box will be displayed with the automatically assumed range of cells to be added (B3 to E3)
• Click OK. The result is displayed as shown. We can even choose the range of cells added manually.

• The total marks scored by the other students have to be added in the same way by making use of the SUM() function.

• Instead entering the same function for all the students in the example we can copy the formula to the cells in the total column to add B4:E4, B5:E5, B6:E6 and so on.

• When we copy the SUM() function formula from the cell F3 to F4 the SUM function will automatically taking the input range of numbers to be added is B4:E4.

• The same is applicable to the rest of the cells in the total column.

• To copy down the formula place the mouse pointer at the bottom right corner of the cell F3.
• The mouse pointer now automatically changes into + symbol.
• Now drag + symbol down the cells in the Total column.
• We can see the total marks of all the students in the example as shown below.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I-B.Sc.(Agri.) Mid Semester Mark List</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>STAM101 Mark</td>
<td>STAM102 Mark</td>
<td>AGR101 Mark</td>
<td>PBG101 Mark</td>
<td>Total</td>
</tr>
<tr>
<td>3</td>
<td>Angaleeswari</td>
<td>87</td>
<td>85</td>
<td>86</td>
<td>84</td>
<td>342</td>
</tr>
<tr>
<td>4</td>
<td>Bharathi Raja</td>
<td>92</td>
<td>94</td>
<td>96</td>
<td>97</td>
<td>379</td>
</tr>
<tr>
<td>5</td>
<td>Covardhanan</td>
<td>73</td>
<td>90</td>
<td>64</td>
<td>58</td>
<td>285</td>
</tr>
<tr>
<td>6</td>
<td>Dananjayen</td>
<td>54</td>
<td>58</td>
<td>60</td>
<td>63</td>
<td>235</td>
</tr>
<tr>
<td>7</td>
<td>Elevanthan</td>
<td>78</td>
<td>76</td>
<td>77</td>
<td>75</td>
<td>306</td>
</tr>
<tr>
<td>8</td>
<td>Gayathri</td>
<td>66</td>
<td>56</td>
<td>57</td>
<td>86</td>
<td>265</td>
</tr>
<tr>
<td>9</td>
<td>Hariprasad</td>
<td>61</td>
<td>65</td>
<td>66</td>
<td>64</td>
<td>256</td>
</tr>
</tbody>
</table>

Use of in-built function **AVERAGE()**

• To calculate the average marks scored by the students in the example we can make use of average function AVERAGE().
• Enter Average column in the spreadsheet.
• Place the mouse pointer in the cell with the address G3
• The F3 cell is the one which should display the total mark scored by the student namely Angaleeswari in the above example.
• Click on Insert Menu → Function
• or Select fx in the Formula bar
• Insert Function dialog box will get displayed as shown below. Choose AVERAGE() function and click OK.
Click OK button in the Insert Function dialog box.

In the Function Argument dialog box enter F3/4 then click OK button. The average scored is displayed.
• Copy the AVERAGE formula as we copied the SUM().

<table>
<thead>
<tr>
<th>Name</th>
<th>STAM101 Mark</th>
<th>STAM102 Mark</th>
<th>AGR101 Mark</th>
<th>PBG101 Mark</th>
<th>Total</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angaleeswari</td>
<td>87</td>
<td>85</td>
<td>86</td>
<td>84</td>
<td>342</td>
<td>85.5</td>
</tr>
<tr>
<td>Bharathi Raja</td>
<td>92</td>
<td>94</td>
<td>96</td>
<td>97</td>
<td>379</td>
<td>94.75</td>
</tr>
<tr>
<td>Covardhanan</td>
<td>73</td>
<td>90</td>
<td>64</td>
<td>58</td>
<td>235</td>
<td>71.25</td>
</tr>
<tr>
<td>Dananjayen</td>
<td>54</td>
<td>58</td>
<td>60</td>
<td>63</td>
<td>235</td>
<td>58.75</td>
</tr>
<tr>
<td>Elevanthan</td>
<td>78</td>
<td>76</td>
<td>77</td>
<td>75</td>
<td>306</td>
<td>76.5</td>
</tr>
<tr>
<td>Gayathri</td>
<td>66</td>
<td>56</td>
<td>57</td>
<td>86</td>
<td>265</td>
<td>66.25</td>
</tr>
<tr>
<td>Hariprasad</td>
<td>61</td>
<td>65</td>
<td>66</td>
<td>64</td>
<td>256</td>
<td>64</td>
</tr>
</tbody>
</table>

**Writing Expressions**

- The total marks can be calculated by writing expressions.
- Place the cursor the cell F3.
- To enter expression, enter the equal sign first.

- Choose the cells with the cursor as shown.
• Press enter. The result will be displayed in F3. Copy the expression down the Total column to find the total mark scored by all the students in the example.

• To calculate the averages place the G3.

• Enter the equal sign first in the cell G3.

• Enter F3/4 which is the average to be calculated.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>I-B.Sc.(Agri.) Mid Semester Mark List</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Name</td>
<td>STAM101 Mark</td>
<td>STAM102 Mark</td>
<td>AGR101 Mark</td>
<td>PBG101 Mark</td>
<td>Total</td>
</tr>
<tr>
<td>3</td>
<td>Angaleeswari</td>
<td>87</td>
<td>85</td>
<td>86</td>
<td>84</td>
<td>342</td>
</tr>
<tr>
<td>4</td>
<td>Bharathi Raja</td>
<td>92</td>
<td>94</td>
<td>96</td>
<td>97</td>
<td>379</td>
</tr>
<tr>
<td>5</td>
<td>Covardhanan</td>
<td>73</td>
<td>90</td>
<td>64</td>
<td>58</td>
<td>285</td>
</tr>
<tr>
<td>6</td>
<td>Dananjayen</td>
<td>54</td>
<td>58</td>
<td>60</td>
<td>63</td>
<td>235</td>
</tr>
<tr>
<td>7</td>
<td>Elevanthan</td>
<td>78</td>
<td>76</td>
<td>77</td>
<td>75</td>
<td>306</td>
</tr>
<tr>
<td>8</td>
<td>Gayathri</td>
<td>66</td>
<td>56</td>
<td>57</td>
<td>85</td>
<td>265</td>
</tr>
<tr>
<td>9</td>
<td>Hariprasad</td>
<td>61</td>
<td>65</td>
<td>66</td>
<td>64</td>
<td>256</td>
</tr>
</tbody>
</table>

• Press enter. The average will be displayed. Copy the expression down the cells in the Average column to calculate the rest of the averages.
Data Analysis Tools- Correlation and Regression, t-test for two samples and ANOVA with One-way classification

Data Analysis Tools

- Most of Excel’s statistical procedures are part of the Data Analysis ToolPak. This option is available in TOOLS menu.
- The analysis that can be done are:
  - descriptive statistics,
  - t tests,
  - correlations,
  - one or two way analysis of variance,
  - regression,
  - moving average,
  - Fourier analysis etc.
- To start the data analysis click Tools menu. Search for the Data Analysis tab in the Tools menu.
• If Data Analysis is not found in the menu then click Add-Ins…
• In the Add_Ins dialog box check Analysis ToolPak. Then Click OK.

• Now choose the Tools menu. You can find the Data Analysis there.
• Click Data Analysis option in the Tools now.
• Data Analysis dialog box will get displayed as shown:
Correlation

To do the correlation we consider a problem of finding correlation coefficient of data which relates to the Yield in grams (Y) and the Matured Pods (X) of 10 groundnut plants.

The data is entered in the Excel sheet as follows:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The following data relates to the Yield (in gms) and Matured Pods in numbers of 10 groundnut plants</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Yield(Gms)</td>
<td>Matured Pod(in numbers)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>14</td>
<td>16</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>34</td>
<td>40</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>20</td>
<td>21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>16</td>
<td>18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>11</td>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>11</td>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>20</td>
<td>20</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>17</td>
<td>35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>22</td>
<td>17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>17</td>
<td>27</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Choose Correlation from the Data Analysis window then click OK button.

Correlation window will get displayed as follows:
• Enter the input range if you know the input range of data or else make use of the address icon to mark the input range in the Excel sheet. In this example the input range is A2:B12.
• Since the data are grouped by column in this example, choose Grouped By Columns option.
• We can add the labels as the first row in the data range. So check the Labels in First Row.
• In the output options choose where you want to display the output. In this example the output range is given as D2.

• Click OK button in the Correlation window.

• The result will be displayed from D2 as shown below:
Regression

- To do the regression analysis we consider an example with paddy yield in Kg as the dependent variable and ear length in cm as the independent variable.
- The data are entered in the Excel sheet as follows:

<table>
<thead>
<tr>
<th></th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Test to the Yield (in gms) and Matured Pods in numbers of 10 groundnut plants</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>Matured Pod (in numbers)</td>
<td></td>
<td>Yield (Gms)</td>
<td>Matured Pod (in numbers)</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>16</td>
<td></td>
<td>Yield (Gms)</td>
<td>1</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>40</td>
<td></td>
<td>Matured Pod (in numbers)</td>
<td>0.72362809</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>21</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>18</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>14</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td>13</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>20</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td>35</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>17</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td>27</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Regression procedure in the Data Analysis tools lets you choose one column as the dependent variable, and a set of contiguous columns for the independents.

It does not tolerate any empty cells anywhere in the input ranges.

Therefore, if there is any empty cells in the input range, delete the rows contain empty cells.

Choose Regression from Data Analysis and click OK.
In the Regression window enter the Y and X ranges if you know the address values or else the click the colored icon in the Y and X range tabs to fill the addresses.

If the first row of the data entered includes labels then check the Labels box in the Regression window.

Let the confidence level be set to 99%.

In the output options choose where you want to display the output of regression analysis. In this example the Output Range is set to E2.

Click OK. The result will be displayed from E2 as shown below:
t-test for two samples

- t-test for two samples assuming equal variances: yield of food in kg/ha in Kharif and Rabi season from 1996-97 to 2006-07.
- The data is entered in Excel sheet as shown below:

```
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Perform t-test for two samples assuming equal variances: yield of food in kg/ha in Kharif and Rabi season from 1996-97 to 2006-07.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Year</td>
<td>Kharif</td>
<td>Rabi</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1996-97</td>
<td>89</td>
<td>104</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1997-98</td>
<td>94</td>
<td>108</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1998-99</td>
<td>94</td>
<td>116</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1999-2000</td>
<td>78</td>
<td>105</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2001-02</td>
<td>95</td>
<td>119</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>2002-03</td>
<td>92</td>
<td>130</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2003-04</td>
<td>106</td>
<td>131</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>2004-05</td>
<td>104</td>
<td>134</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>2005-06</td>
<td>105</td>
<td>142</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>2006-07</td>
<td>110</td>
<td>145</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

- Choose t-Test: Two-Samples assuming Equal Variances in the Data Analysis window:
• In the t-Test: Two-Samples assuming Equal Variances window enter the Variable 1 Range and Variable 2 Range.
• Check the Labels option
• Hypothesized mean difference be 0.5
• Let Alpha value be 0.05
• Set output range as E2.

• The result will be displayed from E2 as shown below:
ANOVA with One-way Classification

- Perform ANOVA One Way Classification for yield of food in kg/ha in three seasons from 1996-97 to 2006-07
- The data is entered in Excel sheet as follows:
• Choose ANOVA: Single Factor from Data Analysis window.

![Data Analysis Window](image)

• In the ANOVA: Single Factor window enter the input range. The input range in the example is B2:D13
• Choose Group by Columns
• Check Labels in the first row
• Output range is set to F2 as follows:
The result of the ANOVA with One-way classification is displayed from F2 as shown below:

<table>
<thead>
<tr>
<th>Year</th>
<th>SEASON1</th>
<th>SEASON2</th>
<th>SEASON3</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-97</td>
<td>89</td>
<td>104</td>
<td>130</td>
</tr>
<tr>
<td>97-98</td>
<td>94</td>
<td>109</td>
<td>134</td>
</tr>
<tr>
<td>98-99</td>
<td>94</td>
<td>116</td>
<td>135</td>
</tr>
<tr>
<td>99-2000</td>
<td>78</td>
<td>105</td>
<td>135</td>
</tr>
<tr>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td>142</td>
</tr>
<tr>
<td>2001-02</td>
<td>95</td>
<td>119</td>
<td>143</td>
</tr>
<tr>
<td>2002-03</td>
<td>92</td>
<td>130</td>
<td>144</td>
</tr>
<tr>
<td>2003-04</td>
<td>106</td>
<td>131</td>
<td>150</td>
</tr>
<tr>
<td>2004-05</td>
<td>104</td>
<td>134</td>
<td>152</td>
</tr>
<tr>
<td>2005-06</td>
<td>105</td>
<td>142</td>
<td>154</td>
</tr>
<tr>
<td>2006-07</td>
<td>110</td>
<td>145</td>
<td>160</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Year</th>
<th>SEASON1</th>
<th>SEASON2</th>
<th>SEASON3</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-97</td>
<td>89</td>
<td>104</td>
<td>130</td>
</tr>
<tr>
<td>97-98</td>
<td>94</td>
<td>109</td>
<td>134</td>
</tr>
<tr>
<td>98-99</td>
<td>94</td>
<td>116</td>
<td>135</td>
</tr>
<tr>
<td>99-2000</td>
<td>78</td>
<td>105</td>
<td>135</td>
</tr>
<tr>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td>142</td>
</tr>
<tr>
<td>2001-02</td>
<td>95</td>
<td>119</td>
<td>143</td>
</tr>
<tr>
<td>2002-03</td>
<td>92</td>
<td>130</td>
<td>144</td>
</tr>
<tr>
<td>2003-04</td>
<td>106</td>
<td>131</td>
<td>150</td>
</tr>
<tr>
<td>2004-05</td>
<td>104</td>
<td>134</td>
<td>152</td>
</tr>
<tr>
<td>2005-06</td>
<td>105</td>
<td>142</td>
<td>154</td>
</tr>
<tr>
<td>2006-07</td>
<td>110</td>
<td>145</td>
<td>160</td>
</tr>
</tbody>
</table>

### Anova: Single Factor

- **Input**: Input Range
- **Grouped By**: Columns
- **Labels in first row**: Checked
- **Alpha**: 0.05

### Output options

- **Output Range**: S$2
- **New Worksheet Ply**: Checked
- **New Workbook**: Checked

### Groups Summary

<table>
<thead>
<tr>
<th>Groups</th>
<th>Count</th>
<th>Sum</th>
<th>Average</th>
<th>Variance</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEASON1</td>
<td>11</td>
<td>1060</td>
<td>96.36364</td>
<td>84.65455</td>
</tr>
<tr>
<td>SEASON2</td>
<td>11</td>
<td>1355</td>
<td>123.1818</td>
<td>203.3636</td>
</tr>
<tr>
<td>SEASON3</td>
<td>11</td>
<td>1579</td>
<td>143.5455</td>
<td>91.67273</td>
</tr>
</tbody>
</table>

### ANOVA

<table>
<thead>
<tr>
<th>Source of Variation</th>
<th>SS</th>
<th>df</th>
<th>MS</th>
<th>F</th>
<th>P-value</th>
<th>F crit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between Groups</td>
<td>12230.06</td>
<td>2</td>
<td>6115.03</td>
<td>48.67141</td>
<td>3.82E-10</td>
<td>3.31583</td>
</tr>
<tr>
<td>Within Groups</td>
<td>3796.906</td>
<td>30</td>
<td>126.5639</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>16116.97</td>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**t-test for two samples and ANOVA with One-way classification**

**t-test for two samples**

- **t-test for two samples assuming equal variances:**
  - Example: Perform t-test for two samples assuming equal variances for yield of food in kg/ha in Kharif and Rabi season from 1996-97 to 2006-07.
  - The data is entered in Excel sheet as shown below:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Year</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>96-97</td>
<td>89</td>
<td>104</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>97-98</td>
<td>94</td>
<td>109</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>98-99</td>
<td>94</td>
<td>118</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>99-2000</td>
<td>78</td>
<td>105</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2001-2002</td>
<td>95</td>
<td>119</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>2002-2003</td>
<td>92</td>
<td>130</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2003-2004</td>
<td>106</td>
<td>131</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>2004-2005</td>
<td>104</td>
<td>134</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>2005-2006</td>
<td>105</td>
<td>142</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>2006-2007</td>
<td>110</td>
<td>145</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- Choose t-Test: Two-Samples assuming Equal Variances in the Data Analysis window:
• In the t-Test: Two-Samples assuming Equal Variances window enter the Variable 1 Range and Variable 2 Range.
• Check the Labels option
• Hypothesized mean difference be 0.5
• Let Alpha value be 0.05
• Set output range as E2.

The result will be displayed from E2 as shown below:
ANOVA (Analysis of Variances) with One-way Classification

- Example: Perform ANOVA One Way Classification for yield of food in kg/ha in three seasons from 1996-97 to 2006-07

- The data is entered in Excel sheet as follows:

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Year</td>
<td>Khair</td>
<td>Rabi</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1996-97</td>
<td>89</td>
<td>104</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1997-98</td>
<td>94</td>
<td>109</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1998-99</td>
<td>94</td>
<td>116</td>
<td>Mean</td>
<td>98.36364</td>
<td>123.1815</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>1999-2000</td>
<td>78</td>
<td>105</td>
<td>Variance</td>
<td>64.65455</td>
<td>203.3636</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td>Observatio</td>
<td>11</td>
<td>11</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>2001-2002</td>
<td>95</td>
<td>119</td>
<td>Pooled Va</td>
<td>144.0091</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>2002-2003</td>
<td>92</td>
<td>130</td>
<td>Hypotenis</td>
<td>0.5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>2003-2004</td>
<td>106</td>
<td>131</td>
<td>df</td>
<td>20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>2004-2005</td>
<td>104</td>
<td>134</td>
<td>t Stat</td>
<td>-5.33373</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>2005-2006</td>
<td>105</td>
<td>142</td>
<td>P(T&lt;=t) on</td>
<td>1.595E-05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>2006-2007</td>
<td>110</td>
<td>145</td>
<td>t Critical on</td>
<td>1.724718</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td></td>
<td></td>
<td></td>
<td>P(T&lt;=t) tw</td>
<td>3.17E-05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td>t Critical tw</td>
<td>2.085362</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
• Choose ANOVA: Single Factor from Data Analysis window.

• In the ANOVA: Single Factor window enter the input range. The input range in the example is B2:D13

• Choose Group by Columns
Check Labels in the first row

Output range is set to F2 as follows:

<table>
<thead>
<tr>
<th>Year</th>
<th>SEASON1</th>
<th>SEASON2</th>
<th>SEASON3</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-97</td>
<td>89</td>
<td>104</td>
<td>130</td>
</tr>
<tr>
<td>97-98</td>
<td>94</td>
<td>109</td>
<td>134</td>
</tr>
<tr>
<td>98-99</td>
<td>94</td>
<td>116</td>
<td>136</td>
</tr>
<tr>
<td>99-2000</td>
<td>78</td>
<td>105</td>
<td>136</td>
</tr>
<tr>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td>142</td>
</tr>
<tr>
<td>2001-2002</td>
<td>96</td>
<td>119</td>
<td>143</td>
</tr>
<tr>
<td>2002-2003</td>
<td>92</td>
<td>130</td>
<td>144</td>
</tr>
<tr>
<td>2003-2004</td>
<td>106</td>
<td>131</td>
<td>150</td>
</tr>
<tr>
<td>2004-2005</td>
<td>104</td>
<td>134</td>
<td>152</td>
</tr>
<tr>
<td>2005-2006</td>
<td>105</td>
<td>142</td>
<td>154</td>
</tr>
<tr>
<td>2006-2007</td>
<td>110</td>
<td>145</td>
<td>160</td>
</tr>
</tbody>
</table>

The result of the ANOVA with One-way classification is displayed from F2 as shown below:
Perform ANOVA One Way Classification for yield of food in kg/ha in three seasons from 1996-97 to 2006-07

<table>
<thead>
<tr>
<th>Year</th>
<th>SEASON1</th>
<th>SEASON2</th>
<th>SEASON3</th>
<th>Anova: Single Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>96-97</td>
<td>89</td>
<td>104</td>
<td>130</td>
<td></td>
</tr>
<tr>
<td>97-98</td>
<td>94</td>
<td>109</td>
<td>134</td>
<td>SUMMARY</td>
</tr>
<tr>
<td>98-99</td>
<td>94</td>
<td>116</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>99-2000</td>
<td>78</td>
<td>105</td>
<td>135</td>
<td></td>
</tr>
<tr>
<td>2000-01</td>
<td>93</td>
<td>120</td>
<td>142</td>
<td></td>
</tr>
<tr>
<td>2001-2002</td>
<td>95</td>
<td>119</td>
<td>143</td>
<td></td>
</tr>
<tr>
<td>2002-2003</td>
<td>92</td>
<td>130</td>
<td>144</td>
<td></td>
</tr>
<tr>
<td>2003-2004</td>
<td>106</td>
<td>131</td>
<td>150</td>
<td></td>
</tr>
<tr>
<td>2004-2005</td>
<td>104</td>
<td>134</td>
<td>152</td>
<td></td>
</tr>
<tr>
<td>2005-2006</td>
<td>106</td>
<td>142</td>
<td>164</td>
<td></td>
</tr>
<tr>
<td>2006-2007</td>
<td>110</td>
<td>145</td>
<td>160</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Source of Variation</th>
<th>SS</th>
<th>df</th>
<th>MS</th>
<th>F</th>
<th>P-value</th>
<th>F crit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between Groups</td>
<td>12220.06</td>
<td>2</td>
<td>6110.03</td>
<td>48.67141</td>
<td>3.82E-10</td>
<td>3.31583</td>
</tr>
<tr>
<td>Within Groups</td>
<td>3796.909</td>
<td>30</td>
<td>126.5636</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total</td>
<td>16116.97</td>
<td>32</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
LECTURE SCHEDULE 12

CREATING GRAPHS

Graphs or Charts

- The graphical representation of data is called graph or chart.
- The data entered in the excel sheet can be represented by a graph or a chart.
- MSEXCEL supports a wide variety of graphs.
- Example of graphs:
  - Column, Line, Bar, Pie, Area, Doughnut, Radar, Surface, Bubble, Stock etc.

Column Graph

- It shows data change over a period of time or illustrates comparisons among items.
- Categories are organized horizontally and values vertically.
- It is an idel chart for showing the variation in the value of an item over period of time.

Bar Graph

- Bar graph illustrates comparison among individual items.
- Categories are vertically organized and values horizontally.

Line Graph

- A line graph shows trends in data at equal intervals.
- It is very useful to show the change in the value over a period of time.
- It will show very clearly whether a value is ascending or descending.
Pie Chart

- Pie chart is used to plot data for a single data series.
- Each data point is represented by one piece of the circular pie chart.
- The size of each piece is proportional to the value it represents, so all the data points taken together will form circle.

Area Graph

- Area chart is similar to line chart.
- But plots series one above the other with different colors and shades.
- It emphasizes the magnitude of change over a period of time.

XY (Scatter) Graph

- It plots each point with a mark of two groups of numbers as one series of XY coordinates.
- It shows uneven intervals of data and it is commonly used for scientific data.

CREATING GRAPHS

- Create a spreadsheet with data rice yield in tones from the year 1998 to 2004 as shown below:
<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td><strong>Rice Yield Analysis</strong></td>
</tr>
<tr>
<td>2</td>
<td>Year</td>
<td>Rice Yield (tones)</td>
</tr>
<tr>
<td>3</td>
<td>1998</td>
<td>546,858.95</td>
</tr>
<tr>
<td>4</td>
<td>1999</td>
<td>895,745.77</td>
</tr>
<tr>
<td>5</td>
<td>2000</td>
<td>1,025,892.62</td>
</tr>
<tr>
<td>6</td>
<td>2001</td>
<td>2,548,955.55</td>
</tr>
<tr>
<td>7</td>
<td>2002</td>
<td>5,895,458.25</td>
</tr>
<tr>
<td>8</td>
<td>2003</td>
<td>7,102,584.65</td>
</tr>
<tr>
<td>9</td>
<td>2004</td>
<td>9,883,529.25</td>
</tr>
</tbody>
</table>

- Go to Insert Menu select Chart and click.
First Step

- A dialog box of chart wizard will appear, select the required type of chart from the chart type.

![Chart Wizard - Step 1 of 4 - Chart Type]

- Then select the chart sub type according to your requirement.

Second Step

- Select the data range in this step.
- To give enter data range move the cursor on excel sheet and
  - by clicking select the data area you want or
  - type cells position if you know exactly which area you want.
- Click on the Next button.
- the data range selected in our example is Sheet1!$A$1:$B$9
- Sheet1 we are in sheet1 in MS Excel.
- $ Sign is used to represent the absolute position of the data in MS Excel.
• The range is to conform that the chart is being prepared of the proper sheet of the file.

• On confirming click on Next button.

Third Step
• Here the Chart title, Category and Value information are entered, which will be displayed when the chart is viewed.
Fourth Step

- This step will provide in the way you want to place the chart.

- Select the appropriate option available in the chart wizard.

- Click the Finish button.

- The chart will be as shown below:
Moving Chart

- If the chart needs to be placed in different position, then we can move the chart wherever we want.

- To move the chart select the chart by clicking on it without levelling the mouse button, drag in the direction you want.

- The chart will move and then release it where you want.

Changing the Chart Size

- To change the chart size, select the chart by clicking on it.

- You will get eight small rectangular boxes around the chart.

- Now move the cursor to the border of the chart and the mouse pointer changes to double headed arrow cursor.
• Then press the left mouse button and drag.

• If you want to reduce the size, drag towards the centre of the chart, else in opposite direction to increase the size of the chart.

**Changing the Chart Type**

• Select the chart

• Click the right mouse button

• From the right context menu select Chart type

• Select the required chart type from the chart type window.
Click OK.

If the selected chart type is Area type then the chart will be as shown below:
MSACCESS: Concept of Database- Units of database, creating database

**Database**
- A database is a collection of interrelated data that is organized so that it can easily be accessed, managed and updated.
- A database-management system (DBMS) is a collection of interrelated data and a set of programs to access those data.

**Characteristics of Database**
- Self-describing- a database gives description about itself.
- Multiple users can access the same data.
- Data exists permanently
- Data security protects the data from unauthorized access with the help of the passwords.
- Many software are used as Database Management Systems. Example: MS-Access, ORACLE etc.
Structure of Database Management System

Tables
- Tables contain data
- The main components of tables are:
  - Field
  - Record
- A field is the smallest data item stored in one particular format.
- A record is one complete set of related field.
- Example: Following is Student table in an University database

<table>
<thead>
<tr>
<th>Student Name</th>
<th>ID</th>
<th>STAM Mark</th>
<th>AGR Mark</th>
<th>PBG Mark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adithi</td>
<td>BSA-10-001</td>
<td>98</td>
<td>99</td>
<td>95</td>
</tr>
<tr>
<td>Bhargavi</td>
<td>BSA-10-002</td>
<td>56</td>
<td>75</td>
<td>67</td>
</tr>
<tr>
<td>Natarajan</td>
<td>BSA-10-003</td>
<td>86</td>
<td>70</td>
<td>75</td>
</tr>
<tr>
<td>Madhavan</td>
<td>BSA-10-004</td>
<td>78</td>
<td>79</td>
<td>76</td>
</tr>
</tbody>
</table>
• The columns in the table are fields or attributes. Fields store the smallest unit of data.
• The rows in the table are called tuple or record. The record is one complete set of relation.

**Database concepts**

- Data is a known fact.
- Data may be name of a student or mark scored by a student or age of a student or date of birth of a student. Thus the type of the data varies, that if it is a name then it will contain only any combination of the alphabets, if it a mark then it will be only a number, if it date of birth then it will only be a date.

- The data types supported by the DBMS are:
  - Numeric - numbers
  - Alphanumeric - letters and digits
  - Date/Time - dates
  - Logical - logical data
  - Auto number - unique value

**Numeric**

- Numbers only (no letters) includes numbers with decimal points.
- Numeric field can contain:
  - Only the numeric characters of 0 to 9
  - The decimal point

**Alphanumeric**

- Alphabets (letter), symbols and numbers
- Alphanumeric data can be made up of the following characters:
  - Numbers 0 to 9
  - Alphabets A to Z, a to z
  - Special characters #, /, $, * etc.

**Data/Time**

- Used to specify the field contains date
**Logical**

- Logical data type used to store Yes or No and True or False

**Auto number**

- A unique value generated for each record.

**Components of database**

- Tables - contains data
- Queries - selected information is displayed on the screen
- Reports - formatted printed information
- Forms - screen created to add, modify, and delete records

**Primary Key**

- The primary key is a field in the table which uniquely identifies that particular record in the table.
- The primary key cannot have a duplicate value in the table.
- Every table should have a primary key associated with it.

**Tasks associated with the tables**

- Creating a table
  - Specifying field names, data types, field sizes
- Adding records to the table
- Modifying data in the table
- Deleting records from the table
- Creating relationship between tables
Tasks associated with the queries

- Creating queries to obtain information
- Creating queries to update data
- Creating queries to update data

MS-Access

- MS-Access is a Relational Database Management System (RDBMS) developed by Microsoft Corporation.
- It provides the software tools to organize the data in a flexible manner.
- It provides facilities to add, modify or delete data from the database, ask questions or queries about the data stored in the database and produce reports summarizing selected contents.

Creating Database

- Click on Start button → Select All Programs → Click Microsoft Access
- The opening screen of the MS-Access will get displayed
As we are going to create a new database, in the New File window click blank database.

File New Database dialog box will get displayed asking us to choose the location of the database and the name of the database. Enter the name of the database as crop.
• Click Create button.

• Crop database is created and crop database window will get displayed as shown below:

• Choose create in Design view option.
- Default name of the table is Table1 will get displayed in the title bar of the Table window.
- Enter the field name under Field Name column.
- Data type can be selected with by clicking the down arrow key in the Data Type column as shown below.

- After choosing the data type of the field set the required field size in the field size tab.
- Enter the description of the field in the Description column.
- Following the above said instructions enter the other fields in the table.
- To set Crop_ID as the primary key of the table right click the field Crop_ID.
- From the right context menu choose Primary Key option.

- A small picture of a key appears next to Crop_ID.
Now the definition of the table structure is complete.
To save the table click the File menu and Save.
In the Save As dialog box specify the name of the table.

Close the table by clicking on File menu and Close option.
The Crop_detail table is displayed in the ‘Tables’ tab as shown below:

Adding Records to the Table

In the design view under the Crop database we have created the table Crop_Detail and assigned Crop_ID as the primary key.
To add the records right click the table Crop_Detail and select Open option.
The datasheet view of the Crop_Detail table will get opened.
- The field names are displayed as headings and a blank row is provided to enter data.
- Enter the data in the corresponding fields. When all the records are added the screen will be as shown below:
To Delete a Record from the table

- To remove the 5th record with Crop_ID CR-005 and Crop_name as aize right click on the arrow (▶) tab in front of the record and choose Delete option as shown below:

- Access prompts the user for the final confirmation because the record once deleted cannot be recalled back.
- Click on ‘Yes’ if you are sure to delete it.
### Crops_Detail : Table

<table>
<thead>
<tr>
<th>Crop_ID</th>
<th>Crop_Cultivated</th>
<th>Crop_Yield</th>
<th>Water_Wastage</th>
<th>Drought_Resistence</th>
</tr>
</thead>
<tbody>
<tr>
<td>CR-001</td>
<td>Bindi</td>
<td>567</td>
<td>24536</td>
<td>Partial</td>
</tr>
<tr>
<td>CR-002</td>
<td>Paddy</td>
<td>1696</td>
<td>29623</td>
<td>Less</td>
</tr>
<tr>
<td>CR-003</td>
<td>Bajra</td>
<td>289</td>
<td>12658</td>
<td>Extreme</td>
</tr>
<tr>
<td>CR-004</td>
<td>Sesame</td>
<td>143</td>
<td>10467</td>
<td>Extreme</td>
</tr>
<tr>
<td>CR-006</td>
<td>Groundnut</td>
<td>952</td>
<td>15489</td>
<td>Less</td>
</tr>
<tr>
<td>CR-007</td>
<td>Cowpea</td>
<td>1045</td>
<td>20567</td>
<td>Moderate</td>
</tr>
<tr>
<td>CR-008</td>
<td>Artichoke</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CR-009</td>
<td>Sorghum</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CR-010</td>
<td>Tobacco</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Microsoft Access**

You are about to delete 1 record(s).

If you click Yes, you won’t be able to undo this Delete operation. Are you sure you want to delete these records?

- [Yes]
- [No]
**Principles of Programming: Flow charts, illustrations through examples**

**Principles of Programming**
- The program or set of programs in a computer that helps in processing the information is called SOFTWARE.
- Software is a detailed writing of stepwise instructions for the computer to carry out the particular task efficiently and properly.
- The art of writing software is called programming.
- Software is an essential part of a computer. Without the software the computer will neither accept information nor give the desired result.

**Algorithm**
- A step-by-step procedure to solve the given problem is known as Algorithm.
- The essential properties of Algorithm are:
  - It should be simple
  - It should be clear with no ambiguity
  - It should lead to a unique solution of the problem.
  - It should involve a finite number of steps to arrive at a solution.
  - It should have the capability to handle some-unexpected situations.
- For example if a student wants to purchase a pen, he has to follow the following steps.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>He has to get money from parents.</td>
</tr>
<tr>
<td>2.</td>
<td>Come out of the House to cross the road</td>
</tr>
<tr>
<td>3.</td>
<td>Check the vehicle movement for safe crossing.</td>
</tr>
<tr>
<td>4.</td>
<td>When it is safe to cross the road, he crosses the road.</td>
</tr>
<tr>
<td>5.</td>
<td>He gets into the shop.</td>
</tr>
<tr>
<td>6.</td>
<td>Asks for a pen.</td>
</tr>
<tr>
<td>7.</td>
<td>Selects a pen from the lot shown to him by the shopkeeper.</td>
</tr>
<tr>
<td>8.</td>
<td>Pays money to the shopkeeper.</td>
</tr>
</tbody>
</table>
These numbered steps are known as Algorithm.

**Flow Chart**
- The graphical or visual representation of algorithm is called as flow chart.
- The flow charts are easier to understand the flow of the solution.
- Flow charts are drawn with the standard symbols accepted worldwide.
- Each standard flow chart symbol represents an action to be performed such as Start or Stop, input operations Read or Write, decision making etc.

**Standard Flow Chart Symbols**

1. Terminal (Start or Stop Symbol)

2. Input / Output

3. Processing

4. Flow Lines: These are arrow mark symbols used to connect two boxes and to indicate the direction of data or processing flow.

5. Decision Box: This is a diamond shaped box, which is used to indicate logical checking and gives decision after comparing between two or more objects (Eg. Yes or No; True or False, =, >, <, etc.)
6. **Connector:** This is a Circular-shaped symbol used to connect different parts of flowchart. When the flow chart is lengthy, it is split into different pages. Then these connectors are used to connect between these pages at the beginning and at the end of each page.

**Illustrations through examples**

1. Algorithm and flow chart to read the name and print the name.

   **Algorithm**
   - Step 1: Start
   - Step 2: Read input name
   - Step 3: Print name
   - Step 4: Stop

   **Flow Chart**

   ![Flow Chart Diagram]
2. Algorithm and flow chart to add two numbers.

Algorithm
Step 1: Start
Step 2: Input first number A
Step 3: Input second number B
Step 4: Add the two numbers and store it in total
Step 5: Print Total
Step 6: Stop

Flow Chart

3. Algorithm and a flow chart to calculate area of square.

Algorithm

Flow Chart
Step 1: Start
Step 2: Read value for a (side)
Step 3: [Compute] Area = A * A
Step 4: Output Area
Step 5: Stop

---

4. Algorithm and flow chart to find the average of three numbers.

**Algorithm**
Step 1: Start
Step 2: Enter Three Numbers A, Band C
Step 3: Compute Average = (A+B+C)/3
Step 4: Print Average
Step 5: Stop

**Flow Chart**

Start

Input A, B

Average = (A + B + C) / 3

Print Average

Stop
5. Algorithm and flow chart to find the largest of two numbers.

**Algorithm**

Step 1: Start  
Step 2: Enter two numbers A and B  
Step 3: Check if A is greater than B if yes go to Step 4 else go to Step 5  
Step 4: Print A is greater than B  
Step 5: Check if B is greater than A if yes go to Step 6 else go to Step 7  
Step 6: Print B is greater than A  
Step 7: Print A is equal to B  
Step 8: Stop
6. Algorithm and a flow chart to find the factorial of a number.

**Algorithm**

Step 1: Start
Step 2: Read N
Step 3: [Initialize all counters] Set FACT= 1, i = 1
Step 4: Compute Fact = Fact * i  Increment i
Step 5: Check if i < = N if true repeat step 4 if false go to step 6
Step 6: Print fact
Step 7: Stop

**Flow Chart**

```
Start

Read N

i = 1
FACT = i

FACT = FACT * i
i = i + 1

If i <= N

Yes

No

Print FACT

Stop
```

**Advantages of Flowchart**

1. **Conveys Better meaning**

   Since a flowchart is a pictorial representation of a program, it is easier for a programmer to understand and explain the logic of the program to other programmers.
2. **Analyses the problem effectively**
   Flow chart helps the programmers to analyze the problem in detail by breaking the flow chart into detailed parts.

3. **Effective Coding**
   It is very easy for the programmers to write the program, because flow chart will give a clear idea of the steps involved.

4. **Systematic Debugging**
   Even after taking the full care in program design, some errors may remain in the program because the programmer might have never thought of a particular case. Using a flow chart can reduce this type of errors. It also enables easy detection of errors.
Internet: World Wide Web (WWW), Concepts

Internet

- Network of interconnected computers around the world.
- A network of computer networks which operates world-wide using a common set of communications protocols.
- a computer network consisting of a worldwide network of computer networks that use the TCP/IP network protocols to facilitate data transmission and exchange.
- Visualization of the various routes through a portion of the Internet:
What do we need to get connected to internet?

• Getting on the Internet requires:
  – Computer
  – Modem
  – Telephone Line
  – Internet Service Provider (ISP)
  – Communication Software

Modem and Telephone Line

• Modem is a communications device that allows us to communicate with another computer through telephone lines.
• Modem is abbreviation of modulator/demodulator.

• Telephone services, such as
  – ISDN,
  – 56K leased lines, and
  – T-1 connections
• offer connections to the Internet at considerably faster connection speeds.

Internet Service Provider (ISP)

• An Internet Service Provider (ISP) is a company that allow you to use their internet connection for a price.
• When you register with an ISP the followings are given:
  – Username
• A unique name that identifies you.
  – Password
• A secret code that prevents other people from using your account.

**Some Popular Internet Service Providers**

• AT&T WorldNet
• Microsoft Network
• America Online
• In India:
  – VSNL (Videsh Sanchar Nigam Limited)
  – MTNL (Mahanagar Telecom Nigam Limited)
  – BSNL (Bharat Sanchar Nigam Limited)
  – Satyam Online

**Communication Software**

• Computer needs communicate
• on software to allow you to get connected to, and interact with, the Internet.
• Communication software is of two types:
  – Software that Helps Establish Basic Internet Connectivity
  – Software that helps to browse, access e-mail etc.

**World Wide Web**

"The World Wide Web is the universe of network-accessible information, an embodiment of human knowledge."
• Tim Berners-Lee, a scientist at CERN (The European Organization for Nuclear Research (French: Organisation Européenne pour la Recherche Nucléaire), invented the World Wide Web (WWW) in 1989.

• The Web was originally conceived and developed to meet the demand for automatic information sharing between scientists working in different universities and institutes all over the world.

• The basic idea of the WWW was to merge the technologies of personal computers, computer networking and hypertext into a powerful and easy to use global information system.

• The World Wide Web, abbreviated as WWW and commonly known as The Web, is a system of interlinked hypertext documents contained on the Internet.

• With a web browser, one can view web pages that may contain text, images, videos, and other multimedia and navigate between them by using hyperlinks.

**Hypertext**

• Hypertext is text displayed on a computer or other electronic device with references (hyperlinks) to other text that the reader can immediately access, usually by a mouse click or keypress sequence.

• Apart from running text, hypertext may contain tables, images and other presentational devices. Hypertext is the underlying concept defining the structure of the World Wide Web, making it an easy-to-use and flexible format to share information over the Internet.

**Web Browser**

• A web browser is a software application for retrieving, presenting, and traversing information resources on the World Wide Web. An information resource is identified by a Uniform Resource Locator (URL) and may be a web page, image, video, or other piece of content.

• Example of Web Browser:
  o Mosaic
  o Internet Explorer
  o Netscape Navigator
Web Page and Websites

- W3 contains several millions of pages of information. Each of these pages is called a Web Page.
- A webpage or web page is a document or resource of information that is suitable for the World Wide Web and can be accessed through a web browser and displayed on a computer screen.
- A web page can contain text, pictures, sound, animation and video.
- A group of related web pages that are linked together form a Web Site.
- The first page of a web site is called the Home Page.
- The Home Page shown below is the Home Page of the official website of Tail Nadu Agriculture University.
Universal Resource Locator

- Each web page has a unique address called Universal Resource Locator (URL).
- Contains unique information about the server and the path on the server to find and retrieve the information.

Example: http://www.usd.edu/trio/tut/start/url.html

<table>
<thead>
<tr>
<th>http://</th>
<th>protocol – rules through which transmission takes place over the internet.</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.usd.edu/">www.usd.edu/</a></td>
<td>server name - computer domain name</td>
</tr>
<tr>
<td>trio/tut/start/</td>
<td>pathname to the directory you are requesting</td>
</tr>
<tr>
<td>url.html</td>
<td>filename you are requesting</td>
</tr>
</tbody>
</table>

Search Engine

- A web search engine is designed to search for information on the World Wide Web. The search results are usually presented in a list of results and are commonly called hits.
- Few examples of web search engines are:
  - Google.com
  - Ask.com
Introduction to Computer Applications

Yahoo.com

Bing.com

TripleMe.com

Shopzilla.com
Web Browsing and Electronic Mail

Web browsing

- Browse means reading superficially or at random.
- Reading information contained in the WebPages on the Internet using browsers is called web browsing.
- A web browser is a software application for retrieving, presenting, and traversing information resources on the World Wide Web.

Understand the browsers
In the address bar of the browser enter the address of the website or enter the address of the any search engine.

If the address entered is a website then the corresponding webpage will get displayed.

If the address entered is of a search engine (For example Google) then the webpage of the corresponding search engine will get displayed as shown below:

- In the search tab enter the information about your search. For example if you want to browse about computers enter the computers in the search tab.
- Then click Search tab.
A set of pages with the links to the webpages which contain information about computer as shown below:

• Clicking the links desired by you will be taking you to those webpages.
Return to a Web Page That You Just Visited

- To return to the last page you visited, click the Back button on the browser toolbar.
- Click the Forward button to retrace your steps and return to pages you visited before you clicked the Back button.
- To see one of the last nine pages you visited in this session, click the tiny black arrow to the right of the Back or Forward button, and then click the page you want from the list.

Find a Web Page That You Visited Today or a Few Weeks Ago

The browsers automatically records Web pages you've visited both today and in the past. It organizes them in folders on the History bar by the day you visited. Within each day, it organizes the Web sites alphabetically in folders, putting each page visited on that site in that folder. Here's how to find pages in the History list:

1. On the Internet Explorer 6 toolbar, click the History button. Internet Explorer 6 opens the History bar on the left side of the screen.

2. In the History bar, click the time period you want to search. For example, you may want to see all the sites you visited today. (Marked (2) as in the figure shown in Step 4.)

3. Click the Web site folder to open the list of pages, and then click the link to the page to
display the Web page itself. (Marked (3) as in the figure shown in Step 4.)

4. History bar showing Web pages sorted by time period

5. When you've finished using the History bar, click the Close button.

Electronic Mail
- Electronic mail, most commonly abbreviated email or e-mail, is a method of exchanging digital messages.
- E-mail systems are based on a store-and-forward model in which e-mail server computer systems accept, forward, deliver and store messages on behalf of users, who only need to connect to the e-mail infrastructure, typically an e-mail server.
Creating Email

The users can have email account in any one of the email services such as gmail, yahoomail, rediffmail etc.
To create an email account in any one these email services the user need to enter the address of the service in the browser first.
The service will prompt the user to know whether a new user or not.
If you are a new user then the service will guide step by step to create your own email id.

Email Addresses

Email addresses are made up of at least two parts. One part is the name of a mail domain that will ultimately translate to either the recipient's host or some host that accepts mail on behalf of the recipient. The other part is some form of unique user identification. Most e-mail addresses are set up like this: it is your username, then an @ ('at') symbol, and then a domain name (something .com, .net, or .org in most cases).
Using Email

Using e-mail is rather straightforward. Once you have an account set up, select the option that says something like "new e-mail message" or "create a new message". The service will prompt with three boxes (called fields):

- To:
- Subject:
- Body
- Attachment

To field: In the To field type the complete e-mail address of the person who will receive the e-mail.

Subject and Body fields: Type anything you want in the subject and body fields, but remember the length of the subject is limited.

Attachments: Click the Attach a file or Attachment link to add files to the message.

Sending the message

Once filling all the required fields and attaching files to the message click Send button to send the message.

You can forward (make a copy) of a message you receive from someone (if you have their permission if necessary) and mail it to someone else with the forward option.

CC and BCC

CC stands for carbon copy. If you want to send a message to multiple people, add the extra people in the CC: field (usually you separate their e-mail addresses by commas).

BCC stands for blind carbon copy. BCC works just like a carbon copy, except the e-mail addresses you type in BCC do not show up to the other recipients. (Example: You send a message To: Mary and BCC: Joey. Joey will see Mary's e-mail address, but Mary won't see Joey's e-mail address because you "blinded" it by putting it in the BCC field.)
CAUTION: You can also get viruses by downloading executable files (usually .com and .exe on Windows computers) from web sites. Don't download or run executable files from web sites you don't trust.
Introduction to Computer Applications